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To make the best use of any Microsoft application, you should have an understanding of 

how it handles fi les and folders. You should also have an idea of what makes the Offi  ce 

products so valuable, not just each one on its own, but as a group of applications. Micro-

soft Offi  ce provides seamless interaction between the diff erent programs so that you can 

quickly move information from one to the other. For example, a chart built in Excel can 

easily be placed in a PowerPoint presentation.

Another one of the advantages of using the various Offi  ce applications is that although 

each one is designed for a diff erent and specifi c use, the style of the user interface has purposely 

been repeated across all applications. The use of the tabs and ribbons and the placement of 

many common commands are similar in each of the applications. For this reason, once you 

learn how to move around the screen and the ribbons in one application, you already have a good understanding of 

how to use another. Table MO 1.1 provides a summary of common terms and commands used in Microsoft Offi  ce.

It is this commitment to integration of style and design that makes Word, Excel, PowerPoint, Access, and 

Outlook (although Outlook is not part of this book) so easy to learn and to use.

P R O J E C T 

Introduction 
Before you create projects with any of the Offi  ce applications, you will practice work-
ing with the basic components common to all the programs. This chapter provides 
an overview of creating and saving fi les and folders. You will discover how the 
 Clipboard works in and between applications. The Quick Access toolbar is a time-
saving feature you can adjust or customize for your needs. Each application has its 
own ways of viewing your work depending on your actions. Zooming the screen in 
and out will also help you gain the best vantage point for your work. You will also 
be introduced to the Backstage view and how its options control the functions 
inside the program.
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The Microsoft Office 
Environment

TABLE  MO1.1 Common terms and commands

Terminology Action

Click Pressing and releasing the left mouse button.

Right-click Pressing and releasing the right mouse button.

Drag Pressing and holding the left mouse button, and then sliding the 
mouse to a diff erent location and releasing the mouse button.

File A document

Folder A place to store fi les and other folders
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P R O J E C T  M I C R O S O F T  O F F I C E  1 A 

Handling Files, Folders, and Clipboard
One of the greatest advantages of Microsoft  Offi  ce is that the collection of the most 
popular offi  ce applications are interconnected in many ways. Th e screen is set up in a 
similar manner and uses ribbons to group related commands. MS Offi  ce works with 
the Windows application to allow you to create and control fi les and folders across ap-
plications. In this project, you will create, copy, delete, paste, and move fi les and folders 
using Windows. Because all MS Offi  ce programs operate on top of Windows, you can 
access fi les and folders no matter what program you are currently using. Th e Clipboard 
(which operates within Windows) allows you to copy and paste material from one ap-
plication to another, such as Word, Excel, or PowerPoint.

PROJECT FILE: http://www.mhhe.com/projectlearn/

PROJECT OBJECTIVES

After completing this project, 

you will be able to:

• Create and organize fi le 
folders.

• Create, save, copy, and move 
fi les.

• Use the Clipboard to copy 
and paste.

Chapter 1  The Microsoft Office Environment  O-3
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O-4  MICROSOFT OFFICE

L E S S O N  M I C R O S O F T  O F F I C E  1A1

File Folders

L E S S O N  O V E R V I E W

S K I L L S  P R E V I E W
Locate the Navigation pane • Start your computer.

 CLICK the Desktop tile.
 DOUBLE-CLICK the Computer icon.
 The Navigation pane runs down the left side of the Computer window.

Open the Documents folder • Locate the Navigation pane in the Computer window.
 Locate the Libraries folder.
 CLICK Documents, or
• CLICK the Documents shortcut on the desktop.

Create a new folder • CLICK the Home tab and locate the New group.
 CLICK New folder.
 Type the name of the folder in the New Folder box.
 PRESS Enter , or
• RIGHT-CLICK in the blank area of the main window.
 CHOOSE New from the menu.
 CLICK Folder from the submenu.
 Type the name of the folder in the New Folder box.
 PRESS Enter .

Rename a folder • RIGHT-CLICK on the folder to display a shortcut menu.
 CLICK Rename to open the naming box on the folder.
 Type the new name.
 PRESS Enter , or
• CLICK on the folder.
 CLICK the HOME tab and locate the Organize group.
 CLICK Rename.
 Type the new name.
 PRESS Enter .

When working on a project, you place all the documents 
you gather or produce for a project in one folder. When 
you need to access any information about the project, you 
open that folder. In this lesson, you will discover how to 
create folders on the computer and how to organize them 
for easy location. When creating folders, they automati-
cally fi le alphabetically, or you can sort them by other cri-
teria such as date or size.

Adding to the effi  ciency of MS Offi  ce is the ability to 
create folders inside of folders. Inside the folder for a major 
project, you can have smaller folders for the various proj-
ect components. Also, it is easy to move a folder from one 
location to another or to copy the entire contents of a 
folder to another location.

It is simple to rename a folder to keep it current with its 
contents. Once you rename it, the folder again sorts alpha-
betically by its new name. You can display your list of fold-

ers in diff erent views such as large icons, extra-large icons, 
or even just a list. Using the navigation pane and expand 
and collapse arrows, you can view the folder tree to see 
how one folder connects to another.

One of the greatest time-savers is the right-click short-
cut menu. These context-sensitive menus are available 
from almost any place inside a Microsoft product. Just 
right-clicking on a folder displays a shortcut menu with 
the most common options that apply to a folder. When 
right-clicking somewhere else, you are presented with a 
diff erent shortcut menu with options that apply to the 
current position of the mouse.

If a folder is no longer needed, you can easily delete it. 
This sends it to the Recycle Bin. Your computer stores the 
material you “delete” in the Recycle Bin just in case you 
need it later, or made a mistake in getting rid of it in the 
fi rst place.
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Chapter 1  The Microsoft Office Environment  O-5

Delete a folder • RIGHT-CLICK on the folder.
 CHOOSE Delete, or
• CLICK on the folder.
 CLICK the HOME tab and locate the Organize group.
 CLICK Delete button.

Expand a folder • Move your cursor to the Navigation pane.
 CLICK the expand arrow  on the left of the folder.

Collapse a folder • Move the cursor to the Navigation pane.
 CLICK the collapse arrow  next to the folder.

P R O J E C T  P R A C T I C E

Start the computer to open the Start window (see Figure MO1.1).
CLICK the Desktop tile.
DOUBLECLICK the Computer icon on the desktop.
Locate the Libraries icon in the Navigation pane (see Figure MO1.2).
CLICK Documents to open the current list of folders.

1

FIGURE MO1.1 Windows 8 Start window

CLICK the Home tab and locate the New group (see Figure MO1.2).
CLICK New Folder to create a new folder in the main window.
Th e new folder is waiting for you to enter a name for it.
TYPE MyLessons

PRESS Enter .
(Result: Th e new folder takes its alphabetical place in the main window listing.)

2

Desktop tile
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O-6  MICROSOFT OFFICE

DOUBLECLICK on the MyLessons folder to open it.
Th e folder is empty.
Use a shortcut to create another folder here inside the MyLessons folder.
RIGHTCLICK in any white area of the main window.
CHOOSE New.
CHOOSE Folder.
TYPE Word to name the folder.
PRESS Enter .
(Result: A folder named Word has been created inside the folder called MyLessons.)

3

Home tab New folder

New group 

Documents 
folder 

Navigation  
pane  

⎧
⎪
⎪
⎪
⎪
⎨
⎪
⎪
⎪
⎪
⎩

FIGURE MO1.2 Navigation pane, Libraries and Documents folder

M O R E  I N F O 

You can see the current folder in the Address bar near the top of the window. 

Notice that the current folder is on the end of the line of folder names. You can jump to any folder along 
that line by clicking on it in the Address bar.

Using the same procedure create four more folders inside the MyLessons folder:
MyExcel

MyPowerPoint

MyAccess

MyOutlook

Now rename the Word folder to match the style of the others.
RIGHTCLICK on the Word folder to display a shortcut menu.
CLICK Rename to open the naming box on the folder.
TYPE MyWord

PRESS Enter .
(Result: Th e fi le named Word has been renamed MyWord.)

4

5
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Chapter 1  The Microsoft Office Environment  O-7

CLICK the VIEW tab to open the View ribbon and locate the Layout group.
Let your mouse hover over the Extra large icons button.
Th is shows what the main window would look like in Extra large icons.
Hover over Medium icons to preview what that would look like (try others if you like).
Th is ability to see the eff ects without actually clicking on the command is called Live Preview.
Move the cursor back to the main window to return to the original List view.
CLICK in a blank area in the main window to close the View ribbon.

You will not need the folder called MyOutlook so you can delete it.
RIGHTCLICK on the MyOutlook folder to display the context-sensitive menu.
CHOOSE Delete to remove the folder.

6

7

T I P 

This shortcut menu is properly called a context-sensitive menu. The choices on the menu are sensitive to 
the options that are available based on where the cursor was when it was right-clicked. If you right-click on 
a folder, it brings up choices specifi c to folders. If you right-click on a blank area of the main window, it 
displays a diff erent set of options specifi c to that context. This is true of almost any element or window in 
an Offi  ce product.

Deleting folders and fi les actually sends them to the Recycle Bin. This is a safety catch in case you acci-
dently delete something you want to keep. To locate something in the Recycle Bin, double-click the Recy-
cle Bin icon on your desktop. After you fi nd the item you wish to return to its place, either click or right-click 
on the item, and choose Restore. If you would like to empty the Recycle Bin, right-click on it and click 
Empty Recycle Bin. When asked about permanently deleting material, click Yes.

H E A D S  U P 

Move your cursor to the Navigation pane.
CLICK Documents to move back to that folder.
CLICK the expand arrow ( ) at the left  of the image next to Documents.
CLICK the expand arrow next to My Documents.
CLICK the expand arrow next to MyLessons.
(Result: Now you can see the entire fl ow of the folders including the fi rst one you created called 
 MyLessons and the ones you created inside it. Th is is referred to as a folder tree.)
CLICK MyLessons in the Navigation pane to display the folders within it on the main window.
CLICK the collapse arrow ( ) next to Documents.
Th is will collapse all the folders (branches of the tree) below the Documents level.
Th e contents of the MyLessons folder remain in the main window.
DOUBLECLICK on MyExcel to open it.
Th e words “Th is folder is empty” are displayed and the folder tree opens on the left .

Move to the Address bar.
CLICK Documents to change what displays in the main window.
Th is does not aff ect what displays in the Navigation pane.
Navigating around your folders is easy when you use a combination of the Navigation pane, the 
 Address bar, and the main window.
DOUBLECLICK MyLessons in the main window.

8

9

10
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Your screen should look similar to Figure MO1.3. Obviously the number of folders diff ers from 
what is shown in the text.

11
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FIGURE MO1.3 Completion of Lesson MO A1
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Chapter 1  The Microsoft Office Environment  O-9

L E S S O N  M I C R O S O F T  O F F I C E  1A2

Creating, Saving, and Handling Files

L E S S O N  O V E R V I E W

Each document you create is called a fi le. It could be text, 
a photograph, an image, a spreadsheet, music, or many 
other things. Files are generally stored inside folders so 
you can organize and locate them easily. This part of the 
project allows us to create a simple fi le and save (store) it 
in a folder. Once you save it, you can reopen it to change it, 
copy it, move it, and even delete it. When saving a fi le, you 
can save it in a folder on your computer or on SkyDrive (a 
storage capability that allows you create an account so 
you can access the fi le from another computer or device 
by logging into your account).

When you fi rst save a fi le, it is given a fi le name. By default, 
the fi le has a name based on the text found in the fi rst line of 

the document (which is likely the title of the document). You 
can easily change it when you fi rst save it, or later. Save fi les in 
diff erent formats using the Save As command.

Move fi les from folder to folder by dragging them from 
one place to another. When a fi le is opened and any type of 
change is made to the contents, a message pops up when you 
close the fi le, asking you if you want to save the new changes.

When you double-click to open a fi le, the computer rec-
ognizes the type of fi le it is and opens the program (called 
an application) that created it. So, if you open an Excel fi le, 
the computer opens Excel fi rst, and then opens the fi le 
within it. The same happens to files created in Word, 
 Access, and PowerPoint.

S K I L L S  P R E V I E W
Create a fi le • Open an application (such as Word).

 CLICK Blank document.
 Enter something in the screen (text, image, table).

Save a fi le • CLICK the FILE tab.
 CLICK Save As from the menu down the left-hand side of the screen.
 CLICK Computer (or SkyDrive if you wish to save the fi les there).
 CLICK My Documents.
 CHOOSE the name and fi le type.
 CLICK Save.

Move (Drag) a fi le • CLICK and hold on the fi le icon.
 DRAG the fi le to the new location.
 Release the mouse.

Rename a fi le • CLICK on the fi le.
 CLICK the Home tab and locate the Organize group.
 CLICK Rename.
 Type the new name.
 PRESS Enter , or
• RIGHT-CLICK on the fi le.
 CHOOSE Rename.
 TYPE the new fi le name.

P R O J E C T  P R A C T I C E

Open Microsoft  Word.
CLICK Blank document to create a new, blank document.
TYPE This is document A

PRESS Enter .
TYPE Your Name

1
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O-10  MICROSOFT OFFICE

To save this simple document as a fi le inside a folder created in the previous lesson:
CLICK the FILE tab.
CLICK Save As from the menu down the left -hand side of the screen.
CLICK Computer under the large Save As column.
CLICK My Documents from the list beneath the Computer column (see Figure MO1.4).
(Result: Th e Save As window appears, opening the Documents folder and inserting the fi rst sentence 
of the newly created fi le as the suggested File name [see Figure MO1.5]. Because documents oft en 
have titles at the top of the page, Word suggests the fi rst line as a fi le name to save time.)

2

M O R E  I N F O 

Saving to Computer places the fi les on the hard drive. You can only access the fi le when you are using or 
connected to that computer. Saving to SkyDrive saves your fi les to a secure Internet site that allows you to 
access your fi les from any Internet connection. SkyDrive requires you to create an account. It is not part of 
the scope of this book.

FIGURE MO1.4 Saving a fi le to the computer in the My Documents folder

To your 
computer

Into the My 
Documents 

folder

Save As 

Th e name of the document is fi ne for your purposes.
Notice the Save as type (just below the fi le name) says “Word Document.”
Th at means the fi le will save in the latest MS Word formatting.
CLICK the Save button at the bottom-right corner of the screen.
(Result: Th e fi le is saved, and you are returned to the document.)
CLICK the FILE tab.
CLICK Close to close the fi le without closing the program.

3
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Chapter 1  The Microsoft Office Environment  O-11

CLICK the File tab to reveal the list of Recent Documents (lists will vary).
You could open the “Th is is document A” fi le by clicking on it under Recent Documents.
CLICK Computer to open the computer folders.
CLICK My Documents to open the Documents folder.
Notice that the fi le you saved sits outside of the MyLessons folder.
You can move the fi le to the MyLessons folder.
DRAG the fi le on top of the MyLessons folder.
A small message appears telling you what will happen when you release the mouse.
When it says Move to MyLessons, release the mouse.
(Result: Th e fi le “Th is is Document A” is moved to the MyLessons folder.)
DOUBLECLICK the MyLessons folder.
Th e “Th is is document A” fi le is now here.
Because this is a Word fi le, move it into the empty folder named MyWord.
DRAG the “Th is is document A” fi le to the MyWord folder.
DOUBLECLICK the MyWord folder to see the fi le has now been moved there.

DOUBLECLICK the “Th is is document A” fi le to open it.
DOUBLECLICK under your name to force Word to place the cursor there.
TYPE I have made a change to the document

CLICK the Close button ( ) in the top right-hand corner of the screen to close Word.
Because the open document was changed, Word asks you if you would like to save it before closing.
CLICK Save.
(Result: Th e fi le is saved and Word is closed.)

4

5

6

FIGURE MO1.5 The Save As window

File name suggested by the 
fi rst sentence in the document 

Save button 

Default fi le 
type 
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O-12  MICROSOFT OFFICE

You do not have to open Word (or any application) fi rst and then open a fi le. When you open a fi le, 
it automatically opens the application that was used to create it.
DOUBLECLICK the Documents shortcut on the desktop.
DOUBLECLICK MyLessons to open the folder.
DOUBLECLICK MyWord to open the folder.
DOUBLECLICK “Th is is document A” to open the fi le.
(Result: Word opens and the fi le opens as well.)

To change the fi rst sentence to read “Th is is document B”:
CLICK the FILE tab.
CLICK Save As.
CLICK Computer.
CLICK MyWord.
Change the File name to read This is document B

CLICK Save.
Close the current fi le (CLICK the FILE tab and CHOOSE Close).
CLICK the FILE tab.
CLICK Computer.
CLICK MyWord.
(Result: Both fi les now appear in the MyWord folder as show in Figure MO1.6.)

7

8

FIGURE MO1.6 MyWord folder with two new fi les inside

DOUBLECLICK “Th is is document A” to open the fi le.
Th is is the fi rst fi le you created (Th e text says, “Th is is document A”).
Notice the very top of the screen (called the Title bar) shows the name of the fi le that is currently open.
PRESS CTRL�O (a shortcut to the Open command).
CLICK “Th is is document B” to open that fi le.
Both fi les are now open in separate windows.

9
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Chapter 1  The Microsoft Office Environment  O-13

Your screen should look similar to Figure MO1.7. Close both documents to return to the MyWord 
folder.

10

FIGURE MO1.7 Completion of Lesson MO A2
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L E S S O N  M I C R O S O F T  O F F I C E  1A3

Copying and Using Clipboard

S K I L L S  P R E V I E W
Copy a fi le • CLICK the fi le to select it.

 CLICK the HOME tab and locate the Clipboard group.
 CLICK Copy, or
• RIGHT-CLICK on the fi le.
 CHOOSE Copy from the shortcut menu.

Paste a fi le into another folder • Copy the fi le.
 DOUBLE-CLICK the other folder to open it.
 CLICK the HOME tab and locate the Clipboard group.
 CLICK Paste, or
• Copy the fi le.
 DOUBLE-CLICK the other folder to open it.
 RIGHT-CLICK inside the folder main window.
 CLICK Paste from the shortcut menu.

Copy or cut text • Select the text you wish to copy or cut.
 RIGHT-CLICK on the selected area.
 CLICK Copy or Cut, or
• Select the text you wish to copy or cut.
 CLICK the HOME tab and locate the Clipboard group.
 CLICK the copy button or cut button icon, or
• Select the text you wish to copy or cut.
 PRESS Ctrl  � C  (to copy) or Ctrl  � X (to cut).

Paste text • Copy or Cut the text.
 RIGHT-CLICK in the new location.
 CHOOSE Paste, or
• Copy or Cut the text.
 CLICK the mouse in the new location.
 CLICK the HOME tab and locate the Clipboard group.
 CLICK the Paste icon (not the word paste), or
• Copy or Cut the text.
 Move the cursor to the new location.
 CLICK in the new location.
 PRESS Ctrl  � V .

L E S S O N  O V E R V I E W

When you create fi les, you can easily move or copy them. 
When you copy something, whether it is a fi le, a folder, text, 
image, or a table, it is sent to the clipboard. Because the 
clipboard exists in the Windows operating system, you can 
retrieve it from any running program until the computer is 
shut down. This allows you to copy an image from Word 
and paste it into PowerPoint. You can copy a table from Ex-
cel and paste it into Word. This fl exibility permits you tight 
control over how things are organized on your computer.

Anything that can be copied can also be cut. This 
also copies it into the clipboard, but removes it from its 

original location. The ability of the clipboard to func-
tion across applications makes it much easier to provide 
consistent information and images within any program 
you use.

The clipboard saves a great deal of time. Without even 
opening a fi le, you can copy it and paste it into another 
folder. In fact, you can copy a folder (which includes all 
the folders and fi les inside it) and paste it to another lo-
cation. All the contents of the original folder copy and 
paste in the new location. This can make sharing fi les 
with others eff ortless.
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Paste from the Clipboard pane • CLICK the Launch button in the Clipboard group.
 The Clipboard pane lists all the text (or images) that are copied or cut.
 CLICK the text you desire on the Clipboard pane and insert it into the current 

location of the cursor.

Clear the Clipboard • CLICK the Launch button in the Clipboard group.
 CLICK Clear All.

P R O J E C T  P R A C T I C E

Locate and open the MyLessons folder in the Documents folder of your computer.
Open the MyWord folder.
CLICK on the “Th is is document A” fi le.
CLICK the HOME tab and locate the Clipboard group.
CLICK Copy (copying can also be done using the right-click shortcut menu).

Once a fi le is copied, it can be moved easily to another folder.
CLICK the Up One Level arrow ( ) at the left  of the Address bar.
DOUBLECLICK MyPowerPoint to open that folder.
CLICK the HOME tab and locate the Clipboard group.
Th e Clipboard options have changed because there is nothing to copy, but there is something to paste.
CLICK Paste.
(Result: Th is “pastes” a copy of the “Th is is document A” fi le in the MyPowerPoint folder.)

1

2

T I P 

The actual Clipboard, while available in almost any application, does not “live” inside of Word, PowerPoint, 
Excel, or any Offi  ce program. It exists in the Windows application that is running your computer. This is why 
it is possible to copy and paste without Word or any program being open. This is also why you can copy 
and paste from one folder to another or even from one application to another. For example, you can copy 
something from Word and paste it in PowerPoint or Excel—and the other way around.

You can also move fi les without copying them fi rst.
Locate the Documents folder icon in the Navigation pane.
CLICK the Expand button.
Locate the My Documents folder icon in the Navigation pane.
CLICK the Expand button.
Locate the MyLessons folder icon in the Navigation pane.
CLICK the Expand button.
DRAG the “Th is is document A” fi le from the main window to the MyExcel folder icon in the 
 Navigation bar (see Figure MO1.8).
(Result: Th e fi le is removed from the MyPowerPoint folder and is now in the MyExcel folder.)

3
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CLICK on the MyExcel folder icon in the Navigation pane.
DOUBLECLICK the “Th is is document A” fi le to open it.
Select the entire text in the fi rst sentence “Th is is document A.”
TYPE This is document C

Save the fi le as “Document C.”
(Result: Th e original document, “Th is is document A,” remains in the folder. A new document, “Docu-
ment C,” will appear in that folder as well. Check the Title bar to see the name of the open document.)

Select your name (the second line of text).
RIGHTCLICK on the selected area to display the shortcut menu.
CLICK the Cut command.
Although the sentence is cut from the document, it still exists on the Clipboard.
DOUBLECLICK below the last sentence to force Word to place the cursor there.
RIGHTCLICK on the cursor to display the shortcut menu.
CLICK the fi rst Paste button to paste your name in place.

4

5

FIGURE MO1.8 Moving a document to the MyExcel folder

This fi le is being 
dragged to the 
MyExcel folder

The shortcut menu brought up three options for pasting. Consider if you had copied text from an-
other document and it was in a different font and font size: The first option (Keep Source Formatting) 
would paste the text in place with the formatting from the other document (the source). The second 
option (Merge Formatting) would paste the new text, but it would be changed to match the format-
ting of the current document. The third option (Keep Text Only) will paste the text in without any 
formatting. Notice that after each option there is a letter in parenthesis. You could press that key to 
choose the paste option.

H E A D S  U P 
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DOUBLECLICK your mouse in the line below your name.
CLICK the HOME tab (if it is not already selected) and locate the Clipboard group.
CLICK the drop-down arrow under the word Paste.
Th e same three options appear.
As you hover over each option, Word displays a preview of what it would look like if pasted.
Once you copy (or cut) something into the Clipboard, you can paste it as many times as you wish.
CLICK back in the document to turn the Paste command off .

Select the fi rst sentence of the document.
PRESS CTRL�C (a shortcut to the Copy command) to copy it to the Clipboard.
Move to the line below your name.
PRESS CTRL�V (a shortcut to the paste command) to paste in the last thing copied or cut to the 
Clipboard.

CLICK the Launch button in the Clipboard group to launch the Clipboard pane (see Figure MO1.9).
Notice there are two items on the Clipboard. Th e top one is the latest one, and that is why it was the 
one that was pasted.
When you have more than one thing copied to the Clipboard, you can choose which one to paste.
CLICK your name in the Clipboard pane to force Word to paste it into the document.

6

7

8

FIGURE MO1.9 Launching the Clipboard pane
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Clipboard keeps gathering up the things you copy.
CLICK the Clear All button in the Clipboard pane to remove all material in the Clipboard.
RIGHTCLICK your mouse on the new line below all the text in the document.
Notice the Paste Options are “grayed out” and cannot be used because Clipboard is empty.

Your document should now appear similar to Figure MO1.10. Close the Clipboard pane and save 
the fi le.

9

10

FP
O

FIGURE MO1.10 Completion of Lesson MO A3
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 1. Files can be stored inside
a. folders.
b. other fi les.
c. the Navigation pane.
d. All of these are correct.

 2. Once a folder or fi le is renamed
a. a copy of the original fi le is stored in the Clipboard.
b. it is automatically resorted alphabetically by the 

new name.
c. it defaults to the fi rst line of text in the document.
d. None of these is correct.

 3. When deleted, fi les are sent to the Recycle Bin and they
a. will be deleted when the computer is shut down.
b. can be restored if you need them.
c. are sent to SkyDrive.
d. None of these is correct.

 4. When you right-click your mouse, it activates
a. a context-sensitive menu.
b. the Mini toolbar.
c. the Save feature.
d. All of these are correct.

 5. Clicking, holding the mouse, and moving a fi le or 
folder to another location is called
a. moving.
b. sliding.
c. dropping.
d. None of these is correct.

 6. A folder can be renamed by
a. right-clicking on the folder.
b. double-clicking on the folder name.
c. using the HOME tab and Organize group.
d. All of these are correct.

 7. When text is cut from a document, it is
a. sent to the Recycle Bin.
b. copied to the Clipboard.
c. deleted from the computer.
d. None of these is correct.

 8. Th e Clipboard exists
a. within Word and Excel.
b. within all MS Offi  ce applications.
c. within the Windows operating system.
d. None of these is correct.

 9. When something is copied from Excel, it can be 
pasted into
a. Word.
b. Access.
c. PowerPoint.
d. All of these are correct.

 10. Anything that is copied onto the Clipboard will
a. be deleted when the computer is shut off .
b. remain available until it is cleared.
c. copied in the Recycle Bin.
d. None of these is correct.

P R O J E C T  M O  1 A :  Q U I Z  A N D  H A N D S  O N  E X E R C I S E S

M U LT I P L E  C H O I C E  Q U I Z

Select the best choice in the following questions to review the project concepts. Good luck!
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H A N D S  O N  E X E R C I S E :  W O R K  I T  O U T  M O  1 A  E 1

In this exercise, you will create folders and copy fi les. You will alter a fi le and save it. You will also move fi les from one 
folder to another and rename the fi les. When completed, your screen should look similar to Figure MO1.11.

FIGURE MO1.11 Work It Out MO 1: completed

Open the Documents folder.

Create a new folder called Exercises.

Open the Exercises folder and create another folder inside it called Project A.

Locate the fi les associated with this lesson and copy the fi le named mo01a.docx.

Move to the Project A folder and paste mo01a.docx there.

Open mo01a.docx (in the Project A folder). Change the title of the document from “Random Text” 
to First File. Close the fi le and choose Save.

Use the Navigation pane to expand the Documents folder, the My Documents folder, and the Exer-
cise folder to show the Project A folder.

Drag the fi le mo01a.docx onto the Navigation pane and move it to the Exercises folder.

Open the Exercises folder and rename the fi le as First File.

Drag the “First File” up to the Project A folder.
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H A N D S  O N  E X E R C I S E :  W O R K  I T  O U T  M O  1 A  E 2

In this exercise, you will create a fi le and place it in a folder. You will alter it, save it, rename it, and move it to other 
folders. When completed, your screen should look similar to Figure MO1.12.

Open the Documents folder if necessary. Open the Exercises folder. Create a new folder called 
 Project A2.

Open Microsoft  Excel and create a new (blank) workbook. Type My First Workbook in the fi rst cell 
and press Enter .

Go to the FILE tab and save the fi le to your Computer – My Documents – Exercises folder with the 
name of Excel1. Close Excel.

Copy the fi le “Excel1” and then paste it in the same Exercises folder. Notice it is automatically 
 renamed “Excel1 – Copy.”

Open the “Excel1 – Copy” fi le. In the cell below the text, type your birthday using this format 
mm/dd/yyyy (if your birthday was February 7, 1998, you would type 02/07/1998). Press Enter .

Go to the File tab and use the Save As command to save the fi le in the Exercises folder as Birthday. 
Close Excel.

Delete the fi le “Excel1 – Copy.”

Drag both the “Excel1” and the “Birthday” fi les in the Project A2 folder.

Use the expand arrows in the Navigation window to open the following folder tree: 
 Documents > My Documents > Exercises > Project A2

Check the window with Figure MO1.12. Close the window.
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FIGURE MO1.12 Work It Out MO 2: completed
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H A N D S  O N  E X E R C I S E :  W O R K  I T  O U T  M O  1 A  E 3

In this exercise, you will create folders and copy fi les. You will alter a fi le and save it. You will also move fi les from one 
folder to another and rename the fi les. When completed, your screen should look similar to Figure MO1.13.

FIGURE MO1.13 Work It Out MO 3: completed

Open the Documents folder. Open the Exercises folder. Open the folder called Project A2.

Open the fi le called “Birthday” (created in the previous exercise).

In the cell A3 (the third one down the fi rst column) type your name. Press Enter .

Save the fi le in the Project A2 folder as Name. Close Excel.

In the Address bar click on Libraries to move to that folder.

Using the Navigation pane and its Expand buttons, open the following folder tree:

 Documents > My Documents > Exercises > Project A2
 DOUBLECLICK on the Project A folder.

Using the Navigation pane, move the fi le “Name” into the Project A folder.

Open the Project A folder and delete the fi le “Name.”

Open the Project A2 folder and delete the fi le “Birthday.”

Double-click the Recycle Bin icon on the desktop. Right-click on the “Name” fi le and restore it. 
Close the Recycle Bin window.

Right-click on the Recycle Bin icon and empty it.

Open the Project A folder to see that the “Name” fi le is restored.
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P R O J E C T  M I C R O S O F T  O F F I C E  1 B 

Customizing the Workplace
Not everyone uses Offi  ce products for the same purposes. One might use Word to write 
a report while another may use it to produce a poster. Someone might use Excel to gener-
ate charts and projections for a business while another might use it to track personal fi -
nances. Because there are so many ways to use the Offi  ce applications, it is important to 
be able to make the environment as effi  cient as possible. Offi  ce provides numerous ways 
to adjust the view, change the zoom, access the most commonly used commands, and 
even change the default settings so you can save time. Learning how to make the most of 
the customizing features allows you to make your Offi  ce uniquely yours.

PROJECT FILE: http://www.mhhe.com/projectlearn

PROJECT OBJECTIVES

After completing this project, 

you will be able to:

• Use, position, and modify 
the Quick Access toolbar.

• Change the view and zoom 
magnifi cation of the screen.

• Control the actions of Offi  ce 
products from the Backstage 
view.
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L E S S O N  M I C R O S O F T  O F F I C E  1B1

Quick Access Toolbar

L E S S O N  O V E R V I E W

The Quick Access toolbar is one of the most useful parts of 
your computer screen. Word, Access, Excel, and PowerPoint 
all feature this handy and easy-to-customize area. While the 
most commonly related commands are grouped on rib-
bons, it is common to fi nd yourself on one ribbon when the 
command you need is on another ribbon. When you fi nd a 
command that you use regularly, the Quick Access toolbar 
allows you to add that command to the toolbar so it remains 
on the screen no matter what ribbon is active.

While adding commands to the Quick Access toolbar 
is simple, so is removing them. This makes it easy to 

customize the toolbar for whatever project you are cur-
rently working on. When you move to another project, 
you can customize the commands you need for that in 
seconds.

You can even move the Quick Access toolbar below the 
Ribbon if it suits your purposes. By clicking More Com-
mands, the Quick Access toolbar immediately sends you to 
the Customize window so you can see all the possible 
commands you can add. Here you can change the order of 
the commands on the toolbar. With one click, you can re-
set the Quick Access toolbar to its original settings.

Use the Quick Access toolbar • Locate the Quick Access toolbar at the top-left corner of the screen.
 CLICK a button to perform the function.

Add a preset command to the 

Quick Access toolbar

• CLICK the drop-down arrow to the right of the Quick Access toolbar.
 CHOOSE the command you wish to add.

Add a command to the Quick 

Access toolbar from any ribbon

• RIGHT-CLICK the button you wish to add to the Quick Access toolbar.
 CHOOSE Add to Quick Access toolbar.

Remove a command from the 

Quick Access toolbar

• RIGHT-CLICK on the button you wish to remove from the Quick Access toolbar.
 CHOOSE Remove from Quick Access toolbar.

Change the location of the 

Quick Access toolbar

• CLICK the drop-down arrow to the right of the Quick Access toolbar.
 CHOOSE Show Below Ribbon (or if the toolbar is already below the ribbon, 

choose Show Above the Ribbon).

Change the order of buttons 

on the Quick Access toolbar

• CLICK the drop-down arrow to the right of the Quick Access toolbar.
 CHOOSE More Commands.
 CLICK the command you wish to move from the window on the right side.
 CLICK the up or down arrow on the right-hand side of the window.

S K I L L S  P R E V I E W

P R O J E C T  P R A C T I C E

Locate the fi les associated with this lesson. Open mo01b1.xlsx. Th is is an Excel fi le so it automati-
cally opens the Excel application fi rst, and then loads the fi le.

CLICK in the number below the city Weston.
TYPE 38625

PRESS Enter .
You have changed the fi le. Now it is time to save the fi le.
Move the mouse to the Quick Access toolbar (see Figure MO1.14).
CLICK the Save button ( ).

1

1
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CLICK the drop-down arrow at the right of the Quick Access toolbar (see Figure MO1.15).
CHOOSE Print Preview and Print.
Th is inserts the Print Preview and Print button onto the Quick Access toolbar.
CLICK the Print Preview and Print button.
(Result: Th is one click does the same as clicking the FILE tab and choosing the Print button.)

3

FIGURE MO1.14 Quick Access toolbar

Quick Access 
toolbar

Save 
command Drop-down 

arrow

FIGURE MO1.15 Adding to the Quick Access toolbar using the drop-down menu
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CLICK the Back arrow ( ) to return to the normal view.
Th e title of the table (“Population by City”) is not centered over the data.
CLICK and HOLD the mouse in the cell that says “Population.”
DRAG the mouse to the cell above “Princeberg.”
Locate the Alignment group.
CLICK the Merge & Center button ( ) (more on this command as you study Excel).
(Result: Th e title is centered across the table.)

Th is command could come in handy even if you were on another tab.
RIGHTCLICK on the Merge & Center button.
CHOOSE Add to Quick Access toolbar.
(Result: Th e Merge & Center command is copied onto the Quick Access toolbar.)

CLICK the Print Preview and Print button in the Quick Access toolbar.Th e Print Preview shows the 
newly aligned title.
CLICK the Back arrow to return to the normal view.
CLICK in the cell C6 (one blank row below the number 38,625).
TYPE Population from the 2011 census

PRESS Enter .

CLICK and HOLD the mouse to select the text you just entered.
DRAG the mouse to the right until it includes column G.
CLICK the Merge & Center button in the Quick Access toolbar to center the text.

Th e Quick Access toolbar can be moved around the screen to suit your needs.
CLICK the drop-down arrow next to the Quick Access toolbar.
CLICK Show Below the Ribbon to move it below the Ribbon.
CLICK the drop-down arrow again.
CLICK Show Above the Ribbon to return it to its original place.
CLICK the drop-down arrow on the Quick Access toolbar.
CLICK More Commands.
Th e Customize the Quick Access Toolbar window shows commands on the left  side you can add to 
the current commands on the right (see Figure MO1.16).
CLICK Copy from the box on the left .
CLICK the Add button between the two boxes to add it to the Quick Access toolbar.
CLICK OK.
(Result: Th e Copy command is added to the Quick Access toolbar.)
RIGHTCLICK on the Copy button in the Quick Access toolbar.
CHOOSE Remove from Quick Access toolbar.
RIGHTCLICK on the Merge & Center button in the Quick Access toolbar.
CHOOSE Remove from Quick Access toolbar.
Do the same for the Print Preview and Print button in the Quick Access toolbar.

All the buttons added to the Quick Access toolbar are removed. Your screen should look similar to 
Figure MO1.17. Close the fi le without saving it.
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FIGURE MO1.16 Customizing the Quick Access toolbar

Click on Copy 
Click on Add 

The command will appear on 
the Quick Access toolbar

FIGURE MO1.17 Completion of Lesson MO B1
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L E S S O N  M I C R O S O F T  O F F I C E  1B2

View and Zoom Controls

L E S S O N  O V E R V I E W

You can adjust the size and magnifi cation window that 
contains the document, the tabs, and the ribbons. You can 
minimize any window to provide more room on the 
screen. When you minimize it, it moves to the Windows 

taskbar at the bottom of the screen. When ready, you can 
maximize the window again to see it. You can move or 
size a window without sending it to the taskbar.

The window of an application does not always show 
the entire document. You can scroll up or down a docu-
ment quickly to view the rest of the document. There are 
also Ribbon Display Options that give you control over the 
ribbons in the window. The Auto-hide Ribbon provides 
the greatest possible view by hiding the Ribbon and tabs, 

as well as expanding to fi t the screen. Clicking on the top 
of the screen temporarily displays the tabs and ribbons. 
The Show Tabs option hides the Ribbon, but leaves the 
tabs visible. When you click on a tab, the Ribbon appears. 
Once you complete a command, the Ribbon disappears.

You can change the view of a document, but it de-
pends on which application is open. For example, Word 
provides a Read Mode, Print Layout, and Outline view. Ex-
cel provides a Normal, Page Break, and Page Layout view. 
It is also easy to change the zoom magnifi cation to make 
the document larger or smaller. No matter how you 
change the view or the zoom, the printing of the docu-
ment is not aff ected.

Minimize the window • Locate the System Menu button on the left end of the Title bar.
 CLICK Minimize, or
• CLICK the Minimize command on the right end of the Title bar.

Maximize the window • If the window is open but not full screen, Locate the System Menu button in 
the Title bar.

 CLICK Maximize, or
• CLICK the Maximize button on the right-hand end of the Title bar.
• If the window is minimized to the Windows taskbar, CLICK the application icon 

on the Windows taskbar.

Move a window • CLICK and HOLD the mouse on the Title bar.
 DRAG the window to the new location.

Size a window • Move the mouse to one of the window borders until a two-headed arrow appears.
 DRAG the edge in, out, up, or down to resize the window.
 Release the mouse.

Scroll through a document • DRAG the Scroll bar up and down.
• CLICK just below (or after) the Scroll bar.
• Rolling the wheel on the mouse (if available) back (toward you) to scroll down 

or forward (away from you) to scroll up.

Change Ribbon Display Options • Move the mouse to the right-hand end of the Title bar.
 CLICK the Ribbon Display Options button.
 CLICK your choice.

Change the view of a document • CLICK the VIEW tab and locate the Views group. (Word, PowerPoint, and Access 
have similar controls.)

 Choose the desired view.

Adjust the zoom magnifi cation • CLICK the VIEW tab and locate the Zoom group.
 CLICK Zoom.
 CLICK to adjust to a preset magnifi cation, or
• DOUBLE-CLICK the Zoom level at the right-hand end of the Task bar.
 Choose the desired zoom.

S K I L L S  P R E V I E W
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P R O J E C T  P R A C T I C E

Locate the fi les associated with this lesson. Open mo01b2.xlsx. Th is is an Excel fi le so it automati-
cally opens the Excel application fi rst, and then loads the fi le.

Locate the System menu button ( ) in the top left -hand corner of the Title bar.
CLICK on that image to display a drop down menu.
CHOOSE Minimize to shrink the window down to the Windows taskbar.
CLICK on the Excel icon in the Windows taskbar to restore the window to its former size.
PRESS Alt � space bar as a shortcut to open the System menu.
CHOOSE Maximize to expand the window to the entire size of the screen.
CLICK on the System Menu button.
CHOOSE Restore to return to the original window size.

1

2

T I P 

The Minimize, Maximize, (along with the Restore, if the window is currently maximized), and Close buttons 
are also displayed on the far right-hand side of the Title bar. These shortcuts will do precisely the same ac-
tions as the commands in the System menu.

Th e System menu has two other commands (Move and Size) that can be performed more easily 
without the System menu.
Move the mouse to the Title bar (generally best if you choose a blank spot on the Title bar).
CLICK and HOLD the mouse.
DRAG the window to a diff erent place on the screen.
RELEASE to mouse to leave the window in the new position.
Move the mouse to one of the window borders until a resizing arrow appears ( ).
DRAG the edge to change the size of the window.
RELEASE the mouse to set the resizing.

Th ink of the Excel screen (or Word, PowerPoint, or Access) window as an actual “window” viewing 
a particular portion of the document.
To see more of the document, you need to move the “window.”
CLICK in any of the data cells on the screen.
You can move the screen down by:
a. Dragging the scroll bar.
b. Clicking just below the scroll bar.
c. Rolling the wheel on the mouse (if available) back (toward you).
You can move up doing the opposite of any of these.

Move the mouse to the right end of the Title bar.
CLICK the Ribbon Display Options button (see Figure MO1.18)
CLICK Auto-hide Ribbon.
(Result: Th e ribbons are gone and the window now fi lls the screen for maximum visibility.)
CLICK anywhere along the top of the window to temporarily bring down the Tab and Ribbon.
CLICK on the main screen to hide the Tab and Ribbon.
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CLICK the Ribbon Display Options button.
CLICK Show Tabs.
(Result: Th e ribbons are gone but the tabs remain.)
CLICK on any tab to reveal the ribbon.
CLICK on the main screen to hide the Ribbon.
CLICK the Ribbon Display Options button.
CLICK Show Tabs and Commands.
(Result: Th e screen returns to the normal tabs and ribbons display.)
CLICK the VIEW tab and locate the Workbook Views group.
CLICK the Page Break Preview to see what would print on page one and what would be on page two.
CLICK Page Layout to see rulers down the left -hand side and across the top of the page.
Th is view also shows a header across the top (Checking the View) that shows when you print.
CLICK Normal view.
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FIGURE MO1.18 Ribbon Display Options

M O R E  I N F O 

The diff erent Offi  ce applications have diff erent types of views available from their View ribbon. Word, 
 PowerPoint, and Access provide diff erent views because the programs are so diff erent in purpose.

Locate the Show group.
CLICK the Formula bar box to uncheck it (the Formula bar disappears).
Uncheck the Gridlines box (the gridlines between the columns and rows disappear).
Uncheck the Headings box (the column and row headings disappear).
CLICK all three of the check boxes to show them again.

9
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Locate the Zoom group.
CLICK the Zoom button to display preset magnifi cations.
CHOOSE 200%.
CLICK OK to make the screen zoom to 200%.
CLICK the Zoom button again.
CHOOSE 50%.
CLICK OK to reduce the zoom factor to 50%.

Th ere are zoom controls along the Status bar (far bottom right of the screen).
CLICK on the Zoom Level (the 50% button).
CHOOSE 100% from the Zoom magnifi cation menu.
CLICK OK.

Return to Normal View.

All Microsoft  Offi  ce products have similar view and zoom controls. You have not made any changes 
to this fi le, so there is no need to save it. Your screen should look similar to Figure MO1.19.
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FIGURE MO1.19 Completion of Lesson MO B1
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L E S S O N  M I C R O S O F T  O F F I C E  1B3

Backstage View and Options

L E S S O N  O V E R V I E W

One of the greatest things about the Offi  ce applications is 
that they are highly customizable. The File tab takes you to 
the Backstage view. From here, you can add or change 
the properties of a document. You can change the way the 
spell checking feature runs. You can set the application to 
a diff erent language. You can decide where to save fi les 
and how often the autosave backs up your work. You can 
customize the Quick Access toolbar and the ribbons to 
contain the commands you most often use. You can even 
change the order of the commands.

Backstage view also allows you to create new docu-
ments or search for templates (a model of a document 
you can adjust for your use). From the Backstage view, you 
can open or save documents quickly. It also provides a 
Print page to control your printer and display the docu-
ment as it will print via the Print Preview.

The Word Options menu allows to you turn on, turn off , 
and adjust the settings on hundreds of default options 
from the Mini toolbar to show measurements in inches, 
centimeters, or millimeters.

Enter Backstage view • CLICK the FILE tab.
 CHOOSE from the Backstage view menu.

Change user name and initials • CLICK the FILE tab.
 CLICK Options.
 CLICK General.
 Locate User name.
 Type in desired name.
 Locate Initials.
 Type in desired initials.

Change options • CLICK the FILE tab.
 CLICK Options.
 Make desired changes.

S K I L L S  P R E V I E W

P R O J E C T  P R A C T I C E

Locate the fi les associated with this lesson. Open mo01b3.docx. Th is is a Word fi le so it automati-
cally opens the Word application fi rst, and then loads the fi le.
CLICK the FILE tab to open the Backstage view (see Figure MO1.20).
Th e Info page provides information on the document.
On the right-hand side, the properties list the size of the fi le, the number of pages, and other details.
CLICK on Add a title.
TYPE Searching the Internet

You just gave the document a title. (Note: Th is does not change the fi le name.)
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CLICK New from the Backstage menu (see Figure MO1.20).
Here you can see what templates are available within the Microsoft  application you are using.
CLICK in the Search box.
TYPE cards and CLICK Search.
Th e program searches for card templates (business cards, greetings cards, etc.).
CLICK Open from the menu on the left -hand side.
Here you can open recent documents (which can save time).
You can open from folders and fi les stored on your computer.
CLICK Save from the menu on the left -hand side. If this is the fi rst time the document is saved the 
Save As dialog box appears.
Enter a name for the document and CLICK Save.
Th e document is saved and returns to normal view.
CLICK the FILE tab to return to the Backstage view.
CLICK Save As.
Th is allows you to save the current document under another name.
CLICK Print from the menu on the left -hand side.
Th is opens the Print and Print Preview window (see Figure MO1.21).
On the right-hand side is the Print Preview.
On the left  are the print options.
Th e print controls diff er depending on which application you are using, but they are all found via 
the Backstage view.
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FIGURE MO1.20 Backstage view
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CLICK Options from the menu on the left  (the other options are not discussed here).
Th e General Option window is displayed (see Figure MO1.22).
Th is is where Word controls most of its behaviors.
Note the check boxes show what is currently active.
Th e Mini toolbar is not discussed here, but if you found it a distraction while working in Word, you 
could uncheck the box to turn it off .
Check the box to turn it back on.

Locate the User name window below Personalize your copy of Microsoft  Offi  ce.
CLICK in the window.
TYPE your name

CLICK in the Initials window.
TYPE your initials

Now, when you save fi les or add comments to a fi le, Word will use your name and initials.
CLICK Display from the Word Options menu.
Again you see that some options are turned on and some are turned off .
Hover the mouse over the Information symbol ( ) aft er Show highlighter marks.
Th is displays an information box with more information on the feature.
CLICK Save to see how Word decides where to save.
Locate the Save documents area.
Locate the spinner for the Save AutoRecover information every 10 minutes.
CLICK the button arrow of the spinner to change it to 9 minutes.
Th is automatically saves your work every 9 minutes.
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FIGURE MO1.21 Print and Print Preview window

Print 
Options

⎧
⎪
⎪
⎪
⎪
⎪
⎪
⎪
⎪
⎪
⎪
⎨
⎪
⎪
⎪
⎪
⎪
⎪
⎪
⎪
⎪
⎪
⎩

Print 
Preview

cou19405_ch01_o001-o043.indd Page O-34  16/07/13  8:58 PM f-479 cou19405_ch01_o001-o043.indd Page O-34  16/07/13  8:58 PM f-479 /201/MH01955/cou19405_disk1of1/0073519405/cou19405_pagefiles/Office/201/MH01955/cou19405_disk1of1/0073519405/cou19405_pagefiles/Office



Chapter 1  The Microsoft Office Environment  O-35

CLICK Proofi ng to see options such as AutoCorrect and Spell Checking.
CLICK Language to see the default language and other languages available.
CLICK Customize Ribbon to see why certain commands appear on specifi c ribbons.
CLICK Quick Access toolbar to see the option page you used a few lessons ago.
CLICK Advanced and scroll about halfway down to fi nd the Display area.
CLICK the drop-down next to Show measurements in units of.
You can change to metric, Microsoft ’s Points, or the old typewriter’s Pica.
Ensure Inches is selected.
CLICK OK to close the Options window. Th is returns you to the normal view of the document.
While we did not change many settings, it is helpful to know where you can go to customize 
Word, Excel, PowerPoint, or Access to suit your needs. You document should appear similar to 
Figure MO1.23. Do not save the fi le before closing.

CLOSE the Word application.
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FIGURE MO1.22 Word Options
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FIGURE MO1.23 Completion of MO B3

cou19405_ch01_o001-o043.indd Page O-36  16/07/13  8:58 PM f-479 cou19405_ch01_o001-o043.indd Page O-36  16/07/13  8:58 PM f-479 /201/MH01955/cou19405_disk1of1/0073519405/cou19405_pagefiles/Office/201/MH01955/cou19405_disk1of1/0073519405/cou19405_pagefiles/Office



Chapter 1  The Microsoft Office Environment  O-37

 1. Th e Quick Access toolbar is available
a. no matter which ribbon is active.
b. in all offi  ce applications.
c. for customizing.
d. All of these are correct.

 2. To add a command to the Quick Access toolbar
a. double-click on the command.
b. right-click on the command.
c. drag the command to the Quick Access toolbar.
d. None of these is correct.

 3. Remove a command from the Quick Access toolbar by
a. right-clicking on the command in the Quick 

Access toolbar.
b. dragging the command off  the Quick Access 

toolbar.
c. clicking the drop-down on the Quick Access 

toolbar and choosing Remove.
d. None of these is correct.

 4. Clicking the () command on the Title bar will
a. maximize the window.
b. open the normal view.
c. size the window.
d. None of these is correct.

 5. Move a window by
a. double-clicking the Title bar.
b. clicking on the text and dragging.
c. right-clicking on the Title bar and dragging.
d. None of these is correct.

 6. You can scroll down a document by
a. dragging the scroll bar.
b. clicking above or below the scroll bar.
c. rolling the mouse wheel up or down.
d. All of these are correct.

 7. Th ere are preset zoom magnifi cations of
a. 50%.
b. 150%.
c. page width.
d. None of these is correct.

 8. Which of these is NOT one of the Backstage view 
menu choices?
a. Share
b. Print
c. Account
d. None of these is correct.

 9. On the Backstage view’s Print page, you can
a. see the print preview.
b. change page orientation.
c. set the number of copies.
d. All of these are correct.

 10. Using the Backstage view, you can change the units 
of measurement
a. in the proofi ng option.
b. in the advanced option.
c. in the general options.
d. None of these is correct.

P R O J E C T  M O  1 B :  Q U I Z  A N D  H A N D S  O N  E X E R C I S E S

M U LT I P L E  C H O I C E  Q U I Z

Select the best choice in the following questions to review the project concepts.
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H A N D S  O N  E X E R C I S E :  W O R K  I T  O U T  M O  1 B  E 1

In this exercise, you will add commands to the Quick Access toolbar, adjust the view and the zoom magnifi cation of the 
document, and change some of the options in the Backstage view. When completed, your screen should look similar to 
Figure MO1.24.

FIGURE MO1.24 Work It Out MO 1: completed

Open Word. Locate and open the fi le mo01b1.docx. Save the fi le as mo01b1.hw1.docx.

Go to the PAGE LAYOUT tab and add the Margins command to the Quick Access toolbar.

Move the Quick Access toolbar to below the Ribbon.

Change the view of the document to Web Layout.

Set the zoom magnifi cation to 90%.

Using the Backstage view, General Word Options, change the Offi  ce Th eme to Dark Gray.

Using the Backstage view, Save Word Options, set Word to AutoRecover every 6 minutes.

Your document should look similar to what is shown in Figure MO1.24.

Because many of the settings you adjusted will remain aft er you close the fi le, return all the settings 
back as they were:
a. Return view to Print Layout.
b. Return zoom to 100% (if it doesn’t occur automatically).
c. Return the Quick Access toolbar to above the Ribbon.
d. Remove the Margins command from the Quick Access toolbar.
e. Return the Offi  ce Th eme setting to White.
f. Return the AutoRecover to 10 minutes.

Save the fi le and close Word.
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H A N D S  O N  E X E R C I S E :  W O R K  I T  O U T  M O  1 B  E 2

In this exercise, you will add commands to the Quick Access toolbar, adjust the view and the zoom magnifi cation of the 
document, and change some of the options in the Backstage view. When completed, your screen should look similar to 
Figure MO1.25.

FIGURE MO1.25 Work It Out MO 2: completed

Open Excel. Locate and open the fi le mo01b2.xlsx. Save the fi le as mo01b2.hw2.xlsx.

Go to the INSERT tab and add the Table command to the Quick Access toolbar.

Using the Quick Access toolbar drop-down, add the Quick Print command.

Change the view of the document to Page Layout.

Set the zoom magnifi cation to 130%.

Using the Backstage view, Info, change the title of the document to Population in MacKenzie 

County.

Using the Backstage view, General Excel Options, change the User name to your name.

Your document should look similar to what is shown in Figure MO1.25.

Because many of the settings you adjusted will remain aft er you close the fi le, return all the settings 
back as they were:
a. Return view to normal.
b. Return zoom to 100% (if it doesn’t occur automatically).
c. Remove the Table and Quick Print commands from the Quick Access toolbar.

Save the fi le and close Excel.

1

2

3

4

5

6

7

8

9

10

cou19405_ch01_o001-o043.indd Page O-39  16/07/13  8:58 PM f-479 cou19405_ch01_o001-o043.indd Page O-39  16/07/13  8:58 PM f-479 /201/MH01955/cou19405_disk1of1/0073519405/cou19405_pagefiles/Office/201/MH01955/cou19405_disk1of1/0073519405/cou19405_pagefiles/Office



O-40  MICROSOFT OFFICE

H A N D S  O N  E X E R C I S E :  W O R K  I T  O U T  M O  1 B  E 3

In this exercise, you will add commands to the Quick Access toolbar, adjust the view and the zoom magnifi cation of the 
document, and change some of the options in the Backstage view. When completed, your screen should look similar to 
Figure MO1.26.

FIGURE MO1.26 Work It Out MO 3: completed

Open Excel. Locate and open the fi le mo01b3.xlsx. Save the fi le as mo01b3.hw3.xlsx.

Go to the View tab and add the Zoom command to the Quick Access toolbar.

Using the Quick Access toolbar drop-down and More Commands, add the Copy command.

Move the Copy command on the Quick Access toolbar so it appears before the Zoom command.

Using the Zoom command in the Quick Access toolbar, change the zoom to 200%.

Using the Backstage view, Info, change the title of the document to Revenues by Region.

Using the Ribbon Display Options, auto-hide the Ribbon.

Your document should look similar to what is shown in Figure MO1.26.

Because many of the settings you adjusted will remain aft er you close the fi le, return all the settings 
back as they were:
a. Return to Show Tabs and Commands.
b. Return zoom to 100% (if it does not occur automatically).
c. Remove the Copy and Zoom commands from the Quick Access toolbar.

Save the fi le and close Excel.
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Th is chapter is vital to prepare you for the integration of the Offi  ce applications. To better understand 
the environment that Microsoft  Offi  ce works in, you fi rst create folders. We examined how folders can 
be put inside other folders, just as you could inside a fi ling cabinet. Th is allows you to keep specifi c 
fi les inside a folder that you will store inside a more general folder. We also saw how easy it is to copy, 
move, and delete folders and fi les. Of course, you can restore your deleted items from the Recycle Bin.

Th is chapter showed how Clipboard is a powerful tool to copy, paste, and move elements around 
a document. Th e Clipboard can even store entire fi les and folders to move or paste in another folder. 
Perhaps its most useful property is Clipboard’s functionality between applications. You can copy 
something from one program and paste it in another program.

One of the greatest time-saving features is the Quick Access toolbar. Because it sits above (or be-
low) the Ribbon, you can access it anytime, no matter what ribbon is currently active. And to make 
the Quick Access toolbar even more useful, customize the commands or reorder them to suit your 
current project.

Each application off ers its own views, so you can change the way the screen appears. Th is also 
includes the ability to zoom in or zoom out from your document by changing the magnifi cation level. 
Th ere are many ways to quickly access the Zoom commands.

Th e Backstage view provides many controls to adjust and customize the way the application be-
haves through its Options page. Th e Backstage view also displays a menu of pages that control print-
ing, saving, opening fi les, and searching for new templates. All these skills are fundamental to making 
the best of the features off ered in Microsoft  Offi  ce 2013.

Chapter Summary

Chapter Key Terms
Auto-hide Ribbon, p •••
Autosave, p •••
Backstage view, p •••
Clipboard, p •••
Context-sensitive menu, p •••
Copy, p •••
Cut, p •••
Dragging, p •••
File, p •••

Folders, p •••
Folder tree, p •••
Maximize, p •••
Minimize, p •••
Mini toolbar, p •••
Navigation pane, p •••
Paste, p •••
Quick Access toolbar, p •••
Recycle Bin, p •••

Save As, p •••
Save, p •••
Scroll, p •••
Show Tabs, p •••
Taskbar, p •••
Templates, p •••
View, p •••
Word Options, p •••
Zoom, p •••

Th is project will provide the opportunity to practice the most important skills covered in this chapter, 
regardless of the lesson in which they were introduced. Th e example shown in Figure MO1.27 is only a 
guideline of how the fi nal project may appear.
Open the Documents folder. Open the MyLessons folder. Create a folder called Comprehensive Exer-
cise. Locate the fi les associated with this chapter and copy mo01cp1a.docx. Paste the fi le in the 
Comprehensive Exercise folder.
 Open the mo01cp1a.docx fi le. Save it in the Comprehensive Exercises folder as comp1a.docx. 
Click on the photograph and copy it. Move to the bottom of the text and paste the picture.
 Add the Paste command from the Home ribbon to the Quick Access toolbar. Open the Custom-
ize Quick Access Toolbar and using the More Commands, add the Copy and Cut commands. Move 
the Copy and Cut commands ahead of the Paste command. Move the Quick Access toolbar below the 
Ribbon.
 Change the Ribbon Display Options to show just the tabs. Set the zoom to Page Width. Change 
the view to Outline. Click the Close Outline View button.

On Your Own Exercise: MO-IC-E1
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FIGURE MO1.27 Comprehensive Exercise 1: completed

 Go to the Backstage view and Save As comp1acopy.docx. Using the Backstage view, give the docu-
ment a title of Online Video. Change the user name to your name and the initials to your initials.
Save this fi le and close Word.

Th is project provides the opportunity to practice the most important skills covered in this chapter, regard-
less of the lesson in which they were introduced. Th e example shown in Figure MO1.28 is only a guideline 
of how the fi nal project may appear.

On Your Own Exercise: MO-IC-E2

FIGURE MO1.28 Comprehensive Exercise 2: completed
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 Open the Documents folder. Open the MyLessons folder. Open the Comprehensive Exercise 
folder. Create a folder here called Final Exercise. Using the Navigation pane and the expand arrows, 
locate the fi les associated with this lesson and move mo01cp2.xlsx in the Final Exercise fi le.
 Open the Final Exercise folder and open the mo01cp2b.xlsx fi le. Click and hold the mouse and 
slide across both columns and all nine rows. Copy this selection. Click in cell D3. Paste the selection 
into this cell. Press ESC to turn off  the copy process.
 Save this fi le in the Comprehensive Exercises folder as comp1b.xlsx.
 Change the Ribbon Display Options to Show Tabs. On the DATA tab, add the Insert Function 
command to the Quick Access toolbar. Using the drop-down arrow add Sort Ascending to the Quick 
Access toolbar. Click in cell D4. Click the Sort Ascending command (it will sort the table you just 
copied).
 Go to Backstage View and then go to the Excel Options page and change the user name to your 

name. Return to the document. Increase the zoom to 130%. Th e document should appear similar to 
Figure MO1.28. Save the fi le and close Excel.
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